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Introduction
Fixed Assets Enhancements allows you to set up and calculate the depreciation for
low cost and low value assets.

Check for current instructions
This information was current as of May 2010. The documentation may be updated
as new information becomes available. Check the Microsoft Dynamics® GP online
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current
documentation.
This introduction is divided into the following sections:
•
•
•
•

What’s in this manual
Symbols and conventions
Resources available from the Help menu
Send us your documentation comments

What’s in this manual
This manual is designed to give you an understanding of how to use the features of
Fixed Assets Enhancements, and how it integrates with the Microsoft Dynamics GP
system.
To make best use of Fixed Assets Enhancements, you should be familiar with
systemwide features described in the System User’s Guide, the System Setup
Guide, and the System Administrator’s Guide.
Some features described in the documentation are optional and can be purchased
through your Microsoft Dynamics GP partner.
To view information about the release of Microsoft Dynamics GP that you’re using
and which modules or features you are registered to use, choose Help >> About
Microsoft Dynamics GP.
The manual is divided into the following chapters:
•

Chapter 1, “Setup and transactions,” explains the depreciation method for low
value assets and the setups required to calculate depreciation.

•

Chapter 2, “Inquiry and reports,” describes how you can view the asset book
information and generate the report for low value pool assets.

Symbols and conventions
For definitions of unfamiliar terms, see the glossary in the manual or refer to the
glossary in Help.
Symbol

Description
The light bulb symbol indicates helpful tips, shortcuts and
suggestions.
The warning symbol indicates situations you should be
especially aware of when completing tasks.
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This manual uses the following conventions to refer to sections, navigation and
other information.
Convention

Description

Creating a batch

Italicized type indicates the name of a section or procedure.

File >> Print or File >
Print

The (>>) or (>) symbol indicates a sequence of actions, such as
selecting items from a menu or toolbar, or pressing buttons in
a window. This example directs you to go to the File menu and
choose Print.

TAB

or ENTER

All capital letters indicate a key or a key sequence.

Resources available from the Help menu
The Microsoft Dynamics GP Help menu gives you access to user assistance
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays
the main “contents” topic. To browse a more detailed table of contents, click the
Contents tab above the Help navigation pane. Items in the contents topic and tab
are arranged by module. If the contents for the active component includes an
“Additional Help files” topic, click the links to view separate Help files that
describe additional components.
To find information in Help by using the index or full-text search, click the
appropriate tab above the navigation pane, and type the keyword to find.
To save the link to a topic in the Help, select a topic and then select the Favorites tab.
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the
Index tab active. To find information about a window that’s not currently displayed,
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics
and descriptions of the fields, buttons, and menus for the window, choose the
appropriate link in the topic. You also can press F1 to display Help about the current
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window.
For example, if the Checkbook Maintenance window is open, you can choose this
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain
information before you can save the record and close the window. You can change
the font color and style used to highlight required fields. On the Microsoft
Dynamics GP menu, choose User Preferences, and then choose Display.
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Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance
resources. Access to some items requires registration for a paid support plan.
Current implementation and upgrade information The most recent
revisions of upgrade and implementation documentation, plus documentation
for service packs and payroll tax updates.
User documentation and resources The most recent user guides, howto articles, and white papers for users.
Developer documentation and resources The most recent
documentation and updated information for developers.
Product support information Information about the Microsoft Dynamics
GP product support plans and options that are available, along with
information about peer support and self-support resources.
Services information Information about Microsoft Dynamics GP support,
training, and consulting services.
Microsoft Dynamics GP Community Access to newsgroups, where you
can ask questions or share your expertise with other Microsoft Dynamics GP
users.
CustomerSource home page A wide range of resources available to
customers who are registered for a paid support plan. Includes access to
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience
Improvement Program to improve the quality, reliability, and performance of
Microsoft® software and services.

Send us your documentation comments
We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.
To send comments about specific topics from within Help, click the Documentation
Feedback link, which is located at the bottom of each Help topic.
Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Chapter 1:

Setup and transactions
Use this information to understand how low value pool assets are depreciated and
to complete the setup procedures to use this method of depreciation. These include
activating low value pool feature, setting up the depreciation method for low value
and low cost assets, creating an asset book and calculating depreciation for low
value and low cost assets.
This information is divided into the following sections:
•
•
•
•
•

Understanding the depreciation method for low value pool assets
Activating low value pool
Setting up the depreciation method for low value pool assets
Transferring assets to low value asset group
Assigning the depreciation method to an asset book

Understanding the depreciation method for low value
pool assets
In some countries/regions, legal authorities specify thresholds to identify low-cost
and low-value assets. These assets must be depreciated in a way that is different
from the usual depreciation practices.
Low-cost assets are assets with an acquisition value of less than the threshold
amount. The depreciation for low cost assets is calculated on the total cost of the
asset. The total cost may include the second element cost, which is the capital cost
incurred on improving the service of the asset.
Low-value assets are assets with an opening net book value of less than the
threshold amount.
You can pool all such low-cost or low-value assets into a single group and
depreciate them using the rate specified by the legal authority from time to time.
You can generate monthly and yearly depreciation reports for these assets. Refer to
Transferring assets to low value asset group on page 7 for more information.
When retiring, if the termination value of the asset is less than the net book value,
you can claim the difference from the tax authorities. If the termination value is
greater than the net book value, the difference is included in the assessable income.
Refer to the Fixed Assets Management documentation for more information.

Activating low value pool
Use the following information to activate the low value pool feature.
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To activate low value pool:
1.

Open the Low Value Pool Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Low
Value Pool >> Low Value Pool Setup)

2.

Mark the Activate Low Value Pool option.

3.

Choose OK to close the window.

Setting up the depreciation method for low value pool
assets
You can set up a depreciation method for low value pool assets in the Depreciation
Method Setup window. The depreciation for the low-cost and low-value assets is
calculated as specified by the authorities. You can use this depreciation method only
for the assets that were depreciated using the reducing balance method in the
previous period.

To set up the depreciation method for low value pool
assets:
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Open the Depreciation Method Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Low
Value Pool >> Depreciation Method Setup)

2.

Enter a name for the depreciation method in the Depreciation Method field.
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3.

Select the frequency to calculate the depreciation in the Period Frequency field.

4.

Enter the threshold amount as specified by the tax authority in the Low Cost
Value field.

5.

Enter the depreciation percentage to calculate depreciation for the first year in
which the assets are assigned to the low value pool asset group.

6.

Enter the depreciation percentage in the Low Value Pool % field to calculate
depreciation for the remaining years.

7.

Choose Save to save the settings.

Transferring assets to low value asset group
You can transfer low-cost and low-value assets from an existing book ID to the book
ID you created for low value assets.

To transfer assets to low value asset group:
1.

Open the Transfer to Low Value Pool window.
(Cards >> Fixed Assets >> Book >> Select an asset ID >> Additional >> Transfer
Asset to low value pool)

The Asset ID and Transfer From Book ID fields display the selected asset and
the book ID that it is currently assigned to.
2.

Enter or select the book ID to assign the selected asset.

3.

Enter or select the depreciation method in the Depreciation Method field.
The Low Value Pool Type field displays the low value asset type for the selected
asset.
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Enter the second element cost in the Amount field. This field is available only if
the selected asset is already transferred to the low value asset group.
The Net Book Value and the Cost Basis fields in the Asset Book window are updated
with this amount for the selected asset.
The Accumulated SEC field displays the total second element cost for the asset.

5.

The Recalculate Remaining option displays that the depreciation is recalculated
for the remaining period for the selected asset.

6.

Choose OK to save the settings and close the window.

Assigning the depreciation method to an asset book
Use this information to assign a depreciation method for low value pool assets to an
asset book you have created in the Book Setup window (Microsoft Dynamics GP
menu >> Tools >> Setup >> Fixed Assets >> Book). Refer to Creating a book record
in Fixed Assets Management documentation for more information. You can set up
various combinations of book IDs and depreciation methods.

To assign the depreciation method to an asset book:
1.

Open the Low Value Pool Book Setup window.
(Microsoft Dynamics GP menu >> Tools >> Setup >> Fixed Assets >> Low
Value Pool >> Low Value Pool Book Setup)

The Company field displays the company name.
2.

Select the book ID to use for low value pool assets.
The Auto Add Book Info option is automatically unmarked for the selected book if you
have marked it in the Book Setup window (Microsoft Dynamics GP menu >> Tools >>
Setup >> Fixed Assets >> Book).
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Select the depreciation method in the Depreciation Method field.

4.

Choose OK to save the settings and close the window.

E N HA N C E M E N T S

Chapter 2:

Inquiry and reports
Use this information to view the book information and print the report for low
value pool assets.
This information is divided into the following sections:
•
•

Viewing the book information for low value pool assets
Printing the report for low value pool assets

Viewing the book information for low value pool
assets
Use the Low Value Pool Book Inquiry window to view the information for an asset
book that you created for low value pool assets.

To view the book information for low value pool assets:
1.

Open the Low Value Pool Book Inquiry window.
(Inquiry >> Fixed Assets >> Book >> Select an asset book >> Additional >>
Low Value Pool Inquiry)

You can view the details for the selected book ID.
2.

Choose OK to close the window.

Printing the report for low value pool assets
Use the Low Value Pool Statement window to print a low value pool asset report.
You can print summary and detail monthly or annual report for the year for low
value pool assets. The report displays the beginning year, net book value, LVA Asset
type, Acquisition/Transfer for the current year, second element cost, disposal value
of the asset, and year to date depreciation amount.

FIXED

ASSETS

ENHANCEMENTS

9

C H A P T E R

2

I N Q U I R Y

A N D

R E PO R TS

To print the report for low value pool assets:

10

F I X E D

AS S E TS

1.

Open the Low Value Pool Statement window.
(Reports >> Fixed Assets >> Low Value Pool Statement)

2.

Select the book ID in the Book ID.

3.

Select whether to generate the yearly detail, yearly summary, or the monthly
report in the Report Type field.

4.

Choose Print to print the low value pool asset report based on your selection.
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Glossary
Low cost asset
An asset with an acquisition value of less
than the threshold amount.

Low value asset
An asset with an opening of net book value
of less than the threshold amount.

Second element cost
The capital cost incurred on improving the
service of an asset.
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Index
B
book information for low value pool
assets, viewing 9

U
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Web 3

W
what’s new, accessing 3

C
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about 3
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the Web 3

D
depreciation method, assigning to an asset
book 8
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documentation, symbols and conventions
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H
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I
icons, used in manual 1

L
lessons, accessing 3
lookup window, displaying 2
low cost and value assets, transferring 7
low value pool, activating 5
Low Value Pool Book Inquiry window,
displaying 9
Low Value Pool Book Setup window,
displaying 8
low value pool report, printing 9
Low Value Pool Setup window,
displaying 6
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displaying 10

N
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R
required fields, described 2
resources, documentation 2

S
symbols, used in manual 1

T
Transfer to Low Value Pool window,
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